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Last Updated: February 2022 (PIX4Dmapper version 4.7.5) 

Pix4Dmapper Image Processing for 
UAS Imagery 

Introduction 
Pix4Dmapper is a photogrammetry software suite compatible with aerial drone imagery that enables 
you to define areas of interest, select processing options, add ground control points (GCPs), and create 
and edit point clouds, digital surface models (DSMs), meshes and orthomosaics. Default templates 
provide automatic processing for new projects and can be customized for more control over data and 
output product quality.  
As you work through this exercise, please refer to the Pix4Dmapper Help Documentation for additional 
information about each of the steps.  The help documentation can be found on the Pix4D website or by 
clicking the Help tab within the software interface.  

Objective 
• Become familiar with the user interface and features found within Pix4Dmapper. 
• Learn how to georeference imagery and create a dense point cloud, a 3D textured mesh, a 

digital surface model (DSM) and an orthomosaic with Pix4Dmapper. 

Prerequisites 
• Download and unzip exercise data: TonyGrove_subset_20191015.zip. 
• Download exercise data Ex1_TonyGrove_GCPs.txt. 
• Review the Appendix located at the end of this document. 
• Install and activate Pix4Dmapper (please see Pix4Dmapper Installation Guide for details). 
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NOTE: If you experience cursor misalignment throughout this exercise, open your File Explorer and 
navigate to your Program Files folder on the Drive you installed Pix4Dmapper. Right click on the 
pix4dmapper.exe file and in the Properties window, select the Compatibility tab. Enable Disable display 
scaling on high DPI settings and click OK. You may need to close and reopen Pix4Dmapper for the cursor 
to be recalibrated. 

Part 1: Getting Started 

https://support.pix4d.com/hc/en-us/categories/360001503192
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In this first part of the exercise, you will navigate the project creation wizard, which consists of five 
windows, to configure important settings and options for your Pix4Dmapper project. This section will 
acquaint you with folder directories where the project outputs will be stored, where you can manage 
the camera model’s parameters, select coordinate systems, and select your processing options 
template.  

A. Create a Project 
1. Launch Pix4Dmapper by searching Pix4Dmapper in the Start menu bar and click New Project. 
2. Name the project TonyGrove and set your file directory. Make sure the radio button for New 

Project is selected and click Next.  

B. Add the imagery 
1. In the Select Images window, click on Add Images and browse to the unzipped folder for 

TonyGrove_subset_20191015 in which the imagery is stored. Select all 105 images and click 
Open, then Next. It may take a moment for Pix4Dmapper to read the geotag data. 

2. Leave the following parameters as their default values: 
i. Datum: WGS 1984; Coordinate System: WGS 84 (EGM 96 Geoid) 
ii. Geolocation Accuracy: Standard 
iii. Selected Camera Model: FC6310_8.8_5472x3648 (RGB) 

NOTE: If your camera model is not included in Pix4Dmapper’s camera model database, or if you want to 
use internal parameters that more accurately represent your camera, you can add a calibrated camera 
model of your own to a Pix4Dmapper project. The project must include a minimum of 50 images 
containing objects at varying distances from the camera, heterogenous textures, a high amount of image 
overlap and if possible, GCPs.  

To add a custom camera model to your database, select Image Properties Editor under the Project tab. 
Under Selected Camera Model, click Edit. Under Camera Model, click New and enter a unique name. 
Under Camera Model Parameters, click Load Optimized Parameters. Once you have entered the camera 
model information, click Save to DB under Camera Model and then click OK. Click No for Save as default 
assignment, then click OK again. Save your project once you have entered your camera model’s 
information into Pix4Dmapper’s database.  

3. Click Next. 
4. In the Select Output Coordinate System window, ensure that the Unit is specified as meters 

(m). 
5. Leave the following parameters as their default values: 

i. Autodetected: WGS  84 / UTM zone 12N 
ii. Advanced Coordinate Options: unchecked. 

NOTE: You can check Advanced Coordinate Options to further explore and set alternative output and 
vertical coordinate systems for adjusting the geoid height but for this exercise, we recommend using the 
default setting.  

6. Click Next.  
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C. Select Template 
1. Under Processing Options Template, navigate to the Rapid tab, then select 3D Maps – 

Rapid/Low Res. 
2. Uncheck Start Processing Now since we’ll explore our processing options before we start 

aligning the images. 
3. Click Finish to finalize the initial project setup. 

NOTE: Depending on what outputs your project requires and what imagery you are loading, you can opt 
for different templates. For producing Point Clouds, DSMs, 3D Meshes and Orthomosaics from aerial 
imagery, you will select either Standard or Rapid 3D Maps. Rapid will produce lower quality results more 
quickly so we will use rapid for this exercise. These options are also good for measuring volumes, 
digitizing houses and roads and generating contour lines. For producing Point Clouds and 3D Meshes 
from ground-based imagery, you will select either Standard or Rapid 3D Models. This option is good for 
3D models of buildings, statues and objects and video fly-through of scenes. If you opt to use Standard 
processing for larger image files, you may want to consider running the process overnight.  

D. Exploring the Main Viewer 
When you have completed your initial project setup, Pix4Dmapper will open in Map View. Map view 
consists of the following main components, color coded to match the following figure:  

 

1. Red: Menu bar 
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Here you can find five menu bar items: Project, Process, View, rayCloud and Help. Depending 
on which tab you select, you can open, save, and create new projects, define properties of 
images and ground control points (GCPs), change your output coordinate system, update 
processing options, change which View Toolbar items are displayed, change navigation modes 
depending and access online support and community forums. 

2. Orange: Toolbar 
Depending on the status of the project and which options have been selected, some buttons 
within the Toolbar may be grayed out. These tools are divided into six subcategories: Project, 
Process, View, Navigation, Clipping and Point Cloud Editing. From these options, you can 
update image geolocation and camera model information, select, or change your coordinate 
system, import, edit, add, or remove ground control points, force open the Quality Report, 
reoptimize your outputs, change how you view your data and edit and correct your point 
cloud if errors occur (e.g., reclassification). On the far right of the Toolbar you can access the 
login information, manage licenses and privacy preferences as well as access the shortcut 
button for turning on and off the Sidebar. 

3. Yellow: Home Tab, View Toolbar 
Home takes you back to your Welcome View window where you can select to generate a new 
project, open an existing project or access community forums and tips.  

4. Light green: Map View Tab, View Toolbar 
Map View will display a 2D map version of your project with a satellite imagery background 
when images are geotagged. 

5. Dark green: rayCloud Tab, View Toolbar 
The rayCloud tab is where you can visualize different elements such as cameras, GCPs, dense 
point cloud output, classification of cloud points and a textured 3D mesh. Here, you can also 
georeference your project, improve accuracy, create orthoplanes and other objects, measure 
distances and surfaces and export your point cloud files. Volumes enables you to draw and 
visualize volumes, measure them and import or export them also. 

6. Purple: Mosaic Editor Tab, View Toolbar 
When Mosaic Editor is selected, you can visualize the DSM, DTM and mosaic, as well as 
improve the visual aspect of the orthomosaic. 

7. Brown: processing Menu 
Under the Processing Menu, Processing Options generates a pop-up window where you can 
edit your parameters for each of the individual steps: Initial Processing, Point Cloud and mesh 
and DSM, Orthomosaic and Index.  

8. Black: Processing View 
The Current bar shows the processing status of each sub-step is displayed as a percentage, 
and the Total bar will show the processing status of all steps that have been selected as the 
number of completed steps. Before hitting the Start button to run the process, each step can 
be checked as to whether the user wants to run the three-step process as a batch, or section 
by section. To stop the processing part way through, the user can hit the Cancel button.  

Part 2: Adding Ground Control Points (GCPs) 
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Pix4D uses GCPs to more accurately place images in space. Ground coordinates for these points 
generally come from another reference image or by collecting the information in the field with a GPS 
unit. The latter method generally produces the most accurate results but is also the more expensive and 
labor intensive of the two. The GCPs provided to you in this exercise were created using the reference-
image method. A minimum of three GCPs is needed for georeferencing the model. For better results, it 
is recommended to distribute five to ten GCPs throughout the model. In this part, you will use three of 
the six GCPs to roughly position and scale the model then you will place the other three later in the 
exercise.  

A. Adding Ground Control Points 
1. Under Project in the main window, click GCP/MTP Manager. 
2. Click Import GCPs. 
3. For Coordinates Order, select X, Y, Z then Browse and locate your Ground Control Point excel 

spreadsheet in the course downloads folder titled Ex1_TonyGrove_GCPs.txt. Click Open and 
OK.  

4. Click Basic Editor.  

NOTE: The basic editor is used before processing the imagery. To add GCPs after processing you should 
use the rayCloud editor, which you will do with the remaining three GCPs later in this exercise.  

GCPs can be manually created using reference imagery and a digital elevation model (DEM), or a 
program such as Google Earth. You can use either of these methods to obtain the reference coordinates 
of markers and take note of the longitude, latitude and elevation of each before inputting the 
information in to the GCP/MTP Table located in the GCP/Manager window. By selecting Add Point, a row 
will be added to the table for a manual tie point which can be located in the imagery and for which 
information can be updated in the sidebar under Selection.  

5. Review the images in the Appendix (located at the end of this document) that show the 
locations of each GCP.  

6. Click on the first GCP in the GCP/MTP Table.  
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Mark the target on each of the corresponding photographs DJI_; 0243.JPG, 0244.JPG, 
0242.JPG, 0193.JPG, 0270.JPG, 0192.JPG, 0194.JPG, 0271.JPG, 0269.JPG, 0241.JPG, 0165.JPG, 
0166.JPG, 0164.JPG, 0319.JPG, 0320.JPG and 0318.JPG. Do this by sorting your images in 
numerical order using the sort button, then double clicking on the image name in the bottom 
left panel and using the controls on the right to zoom in and place the GCP on the thumbnail 
image. Be cautious when placing your markers; some images may include more than one 
marker and it is important to select the correct one to avoid having to restart the process. 
Once completed, check that the number displayed next to the first GCP in the table reads 16. 
This is the number of images in which you have placed the corresponding GCP. 

7. Do the same for the second and third marker.  
i. For the second marker, you will locate the GCP in photographs DJI_; 346.JPG, 345.JPG, 

347.JPG, 318.JPG, 317.JPG, 344.JPG, 319.JPG, 320.JPG, 272.JPG, 271.JPG, 273.JPG, 
270.JPG and 269.JPG. 

ii. For the third marker, you locate the GCP in photographs DJI_; 275.JPG, 274.JPG, 239.JPG, 
238.JPG, 276.JPG, 273.JPG, 240.JPG, 315.JPG, 314.JPG, 316.JPG, 237.JPG, 272.JPG, 
241.JPG, 313.JPG, 317.JPG, 197.JPG, 198.JPG, 196.JPG, 349.JPG, 195.JPG, 350.JPG, 
346.JPG and 347.JPG. 

NOTE: To zoom in on the thumbnail image to place a GCP, you can pinch zoom using your computer’s 
trackpad, use the scroll wheel on your mouse, or drag the pointer on the scale bar to the left with 
magnifying glasses. To pan around the image, you can either left click and hold on your mouse and drag 
the image to the area you want to view, or you can use the arrows above the scale bar on the right. To 
reset the image to its original state, click the button located in the middle of the four arrows used for 
panning.  

8. Once the first three GCPs have been placed on their respective images, click OK.  
9. Under Project in the main window, click Save Project.  
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Part 3: Image Alignment and Calibration 
In general, Pix4Dmapper’s image processing algorithms will be able to access the information about 
your camera’s internal and external parameters prior to processing your imagery. It will do this by 
matching unique textures, represented as keypoints, found within overlapping images. These assist in 
the creation of automatic tie points (ATPs). By running Initial Processing, the software can refine these 
camera-calibration parameters, which improves the accuracy of the 3D model and products.  

A. Image Alignment and Calibration 
1. If you cannot see the Processing menu at the bottom left of the screen, navigate to and click 

on the View tab in the main menu and then click Processing.  
2. In the Processing menu at the bottom left of the main window, confirm that step 1. Initial 

Procesing, step 2. Point Cloud and Mesh, and step 3. DSM, Orthomosaic, and Index are red. 
Ensure that step 1. is checked, and uncheck step 2. and step 3., then click Start. Depending on 
your computer’s technical specifications, this can take a few minutes to run.  

3. Review the generated Quality Report to ensure that your data passes the Quality Checks 
listed at the beginning of the document.This will automatically export as a PDF to your project 
folder and update each time you run a new step 

NOTE: Your Quality Report will also offer insight into Calibration Details where you check if all cameras 
have calibrated correctly in addition to the overlap the images possess and the uncertainties between 
the initial GCP placements versus their computed placements. By using further georeferencing tools 
later, we will try to improve both the meter and pixel accuracy as specified in the Ground Control Points 
Table on page 7.  

4. If not already selected, select the rayCloud tab on the left hand side of the software interface 
and navigate around the cameras and ATP cloud in the main window. Left click and hold to 
pan around and zoom into the point cloud as you move your mouse or finger on your 
trackpad, and hit shift in addition to rotate the point cloud. 

5. Under Project, click Save.  

Part 4: Georeferencing and Reoptimizing 
To mark the remaining GCPs in a sufficient number of images, you will use PIX4Dmapper’s rayCloud. The 
optimal number of images to mark for each GCP is dependent on several factors, including but not 
limited to, image overlap, image content, time it takes to complete the process, etc. Following 
georeferencing, you will reoptimize to ensure overall accurate results. 

A. Georeferencing with rayCloud 
1. Under the View tab in the main menu, ensure rayCloud and Show Sidebar are turned on. 
2. Under Layers on the left-hand side, click the drop-down bar next to Cameras, and do the 

same again for Display Properties. 
3. Under Display Properties, locate the line for Position Error and uncheck the box.  
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4. Drag the edge of the sidebar, located on the right, towards the left of the screen so that it fills 
most of the window. 

5. In the Layers list on the left-hand side, click the drop-down bar next to Tie Points if it is not 
already expanded, and do the same again for GCPs/MTPs and again for Display Properties. 

6. Click on the fourth GCP listed. Collapse the Selection section in the sidebar to close the image 
details and drag the Image Size slider to increase image thumbnail sizes.  

NOTE: As in Part 2, you can place your cursor on each image and zoom in and out using your trackpad or 
mouse scroll wheel. To pan the image, left click and drag. If necessary, hold your cursor over an image 
and tap the spacebar for it to fill your screen if you need to see it at a larger scale. Tap the spacebar 
again to return the image to its original size within the side panel.  

7. Review the Appendix to find the target for the fourth GCP. Try to locate the GCP in image 
DJI_0121.JPG, the first image displayed in the sidebar. Take note that by placing the first three 
GCPs and running the initial processing step, the images containing the GCP have been 
autogenerated and it will now be quicker to place the remaining ones. Click the center of the 
target. Click Delete or drag and drop to reposition the GCP if it is incorrectly placed. If you 
notice something looking odd in this step, revisit Part 2. step 6 to ensure all markers were 
correctly placed. 

8. Confirm the location of the same GCP in the next image, DJI_0122.JPG. The yellow circle that 
appears around the GCP confirms that it has been marked successfully.   

9. Click Selection to expand the GCP’s details and then click Apply. Collapse the Selection 
section once again. This will automatically place the GCP on the remaining images for you.  

10. Drag the Zoom Level slider to the right until you can see the target for the GCP clearly in the 
remaining images. Click on the green crosses to confirm the location of it in each additional 
image. 

11. Expand the Selection section once again and hit Apply. If more images appear, continue 
through the process of confirming the GCP location and clicking Apply until no more new 
images appear. 

12. Follow steps 6. through 12. for the remaining fifth and sixth GCPs. 
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13. Close the sidebar by clicking the “X” to the right of Properties. 

B. Reoptimizing 
1. Under Process, click Reoptimize and then save your project. Click OK if a warning message 

appears.  

NOTE: Running Reoptimize will rerun the first step of the 3-step process, step 1. Initial Procesing if it has 
already been run. If the operation to rerun the first step fails, make sure you do not have the previously 
generated Quality Report open in Adobe.  

Part 5: Creating a Dense Point Cloud and Orthomosaic 
By running step 2. Point Cloud and Mesh, Pix4Dmapper’s image processing algorithms can create a 
dense point cloud assigning each point to a group using ATPs as inputs. The total number of points, 
usually in the thousands to millions, depends on several factors, including but not limited to, image 
overlap, image content, time it takes to complete the process, etc. The dense point cloud will provide a 
3D representation of your study area and enable the generation of a textured mesh and DSM. In step 3. 
DSM, Orthomosaic and Index, you will use the DSM as the input to generate the orthomosaic output.  

A. Generating a Dense Point Cloud 
1. Click on Processing Options in the bottom left-hand corner of the main window. Under the 

Point Cloud and Mesh section, locate the Point Cloud tab at the top. Under the Point Cloud 
Classification section, check Classify Point Cloud.  

2. Click OK to close Processing Options. 
3. In the Processing menu at the bottom left of the screen, confirm that step 1. Initial Procesing 

is green and that step 2. Point Cloud and Mesh, and step 3. DSM, Orthomosaic, and Index are 
red. Uncheck step 1., check step 2 and make sure step 3. is unchecked. Then click Start. 
Expect for this to take several minutes to run. 

4. Close your generated report, then navigate to Layers on the left-hand side of the screen and 
uncheck Cameras and Tie Points.  

5. Under Layers, check Point Clouds and click OK in response to the warning message as shown 
below. Navigate around your dense point cloud. 

 

NOTE: To tilt view your dense point and mesh, hold shift as you left click on your mouse or trackpad and 
move in the direction you would like to view the generated products from. Use the scroll wheel to zoom 
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in and out. Left click to move horizontally. Click and hold the scroll wheel to orbit. To view all points 
within your dense point cloud, hit the View All button on the View toolbar. 

6. Under Project, click Save.  

B. Generating an Orthomosaic 
1. In the Processing menu, ensure that step 1. Initial Procesing is still unchecked, uncheck step 

2. Point Cloud and Mesh and check step 3. DSM, Orthomosaic, and Index. Click Start.This may 
take several minutes to run. 

2. Note how the newly generated Quality Report resembles the previous one with additional 
information about your orthomosaic. Click Close. 

3. On the left-hand side panel, click on Mosaic Editor.  
4. In the main menu at the top of the software interface, click Mosaic Editor, then View 

followed by Show DSM to view your DSM and navigate around the output using the same 
methods to zoom, pan and tilt as described in Parts 4 and 5.  

5. In the main toolbar, click on the Display Mosaic dropdown and select Mosaic (group 1) to view 
and explore the orthomosaic output. 

6. In the Mosaic Editing menu on the right-hand side, click the Export button to have the output 
saved to your project folder pathway, see following figure. If you encounter a warning message 
about exporting your orthomosaic, click OK.  

7. Under Project, click Save.  

NOTE: Sometimes distortion may occur in an orthomosaic whereby you will need to determine whether 
to generate a new product or edit your existing one. If there a relatively low number of distortions, you 
can use the Mosaic Editor to improve your outputs, otherwise consider rerunning step 3. after making 
changes to the project’s parameters by exploring the settings for each step under Processing Options. 

Conclusion: Congratulations! You have completed Pix4Dmapper Image Processing for UAS 
Imagery! In this exercise, we learned how to use Pix4Dmapper to align images, add GCPs for 
georeferencing purposes and create a dense point cloud and orthomosaic. Additional 
resources, including a few tutorials and a very helpful user forum, can be found on the Pix4D 
website. 

https://support.pix4d.com/hc/en-us/categories/360001503192
https://support.pix4d.com/hc/en-us/categories/360001503192


 

 

 
 

Geospatial Technology and Applications Center   |   Pix4Dmapper: Digital Aerial Imagery |   11 

Appendix A: Ground Control Point Locations 
Ground Control Points are crucial for geospatially positioning and scaling the imagery.  Point coordinates 
are generally obtained with a GPS unit in the field or by using a reference image (as was done for this 
exercise). Each Ground Control Point needs to be located and added to each image it intercepts. The 
graphic below shows the marker locations. Refer to the following zoomed-in images to know where to 
place the markers. Since the scale and placement depends upon these markers, it is important to place 
them as accurately as possible. 
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	8. Once the first three GCPs have been placed on their respective images, click OK.
	9. Under Project in the main window, click Save Project.


	Part 3: Image Alignment and Calibration
	A. Image Alignment and Calibration
	1. If you cannot see the Processing menu at the bottom left of the screen, navigate to and click on the View tab in the main menu and then click Processing.
	2. In the Processing menu at the bottom left of the main window, confirm that step 1. Initial Procesing, step 2. Point Cloud and Mesh, and step 3. DSM, Orthomosaic, and Index are red. Ensure that step 1. is checked, and uncheck step 2. and step 3., th...
	3. Review the generated Quality Report to ensure that your data passes the Quality Checks listed at the beginning of the document.This will automatically export as a PDF to your project folder and update each time you run a new step
	NOTE: Your Quality Report will also offer insight into Calibration Details where you check if all cameras have calibrated correctly in addition to the overlap the images possess and the uncertainties between the initial GCP placements versus their com...

	4. If not already selected, select the rayCloud tab on the left hand side of the software interface and navigate around the cameras and ATP cloud in the main window. Left click and hold to pan around and zoom into the point cloud as you move your mous...
	5. Under Project, click Save.


	Part 4: Georeferencing and Reoptimizing
	A. Georeferencing with rayCloud
	1. Under the View tab in the main menu, ensure rayCloud and Show Sidebar are turned on.
	2. Under Layers on the left-hand side, click the drop-down bar next to Cameras, and do the same again for Display Properties.
	3. Under Display Properties, locate the line for Position Error and uncheck the box.
	4. Drag the edge of the sidebar, located on the right, towards the left of the screen so that it fills most of the window.
	5. In the Layers list on the left-hand side, click the drop-down bar next to Tie Points if it is not already expanded, and do the same again for GCPs/MTPs and again for Display Properties.
	6. Click on the fourth GCP listed. Collapse the Selection section in the sidebar to close the image details and drag the Image Size slider to increase image thumbnail sizes.
	NOTE: As in Part 2, you can place your cursor on each image and zoom in and out using your trackpad or mouse scroll wheel. To pan the image, left click and drag. If necessary, hold your cursor over an image and tap the spacebar for it to fill your scr...

	7. Review the Appendix to find the target for the fourth GCP. Try to locate the GCP in image DJI_0121.JPG, the first image displayed in the sidebar. Take note that by placing the first three GCPs and running the initial processing step, the images con...
	8. Confirm the location of the same GCP in the next image, DJI_0122.JPG. The yellow circle that appears around the GCP confirms that it has been marked successfully.
	9. Click Selection to expand the GCP’s details and then click Apply. Collapse the Selection section once again. This will automatically place the GCP on the remaining images for you.
	10. Drag the Zoom Level slider to the right until you can see the target for the GCP clearly in the remaining images. Click on the green crosses to confirm the location of it in each additional image.
	11. Expand the Selection section once again and hit Apply. If more images appear, continue through the process of confirming the GCP location and clicking Apply until no more new images appear.
	12. Follow steps 6. through 12. for the remaining fifth and sixth GCPs.
	13. Close the sidebar by clicking the “X” to the right of Properties.

	B. Reoptimizing
	1. Under Process, click Reoptimize and then save your project. Click OK if a warning message appears.
	NOTE: Running Reoptimize will rerun the first step of the 3-step process, step 1. Initial Procesing if it has already been run. If the operation to rerun the first step fails, make sure you do not have the previously generated Quality Report open in A...



	Part 5: Creating a Dense Point Cloud and Orthomosaic
	A. Generating a Dense Point Cloud
	1. Click on Processing Options in the bottom left-hand corner of the main window. Under the Point Cloud and Mesh section, locate the Point Cloud tab at the top. Under the Point Cloud Classification section, check Classify Point Cloud.
	2. Click OK to close Processing Options.
	3. In the Processing menu at the bottom left of the screen, confirm that step 1. Initial Procesing is green and that step 2. Point Cloud and Mesh, and step 3. DSM, Orthomosaic, and Index are red. Uncheck step 1., check step 2 and make sure step 3. is ...
	4. Close your generated report, then navigate to Layers on the left-hand side of the screen and uncheck Cameras and Tie Points.
	5. Under Layers, check Point Clouds and click OK in response to the warning message as shown below. Navigate around your dense point cloud.
	NOTE: To tilt view your dense point and mesh, hold shift as you left click on your mouse or trackpad and move in the direction you would like to view the generated products from. Use the scroll wheel to zoom in and out. Left click to move horizontally...

	6. Under Project, click Save.

	B. Generating an Orthomosaic
	1. In the Processing menu, ensure that step 1. Initial Procesing is still unchecked, uncheck step 2. Point Cloud and Mesh and check step 3. DSM, Orthomosaic, and Index. Click Start.This may take several minutes to run.
	2. Note how the newly generated Quality Report resembles the previous one with additional information about your orthomosaic. Click Close.
	3. On the left-hand side panel, click on Mosaic Editor.
	4. In the main menu at the top of the software interface, click Mosaic Editor, then View followed by Show DSM to view your DSM and navigate around the output using the same methods to zoom, pan and tilt as described in Parts 4 and 5.
	5. In the main toolbar, click on the Display Mosaic dropdown and select Mosaic (group 1) to view and explore the orthomosaic output.
	6. In the Mosaic Editing menu on the right-hand side, click the Export button to have the output saved to your project folder pathway, see following figure. If you encounter a warning message about exporting your orthomosaic, click OK.
	7. Under Project, click Save.
	NOTE: Sometimes distortion may occur in an orthomosaic whereby you will need to determine whether to generate a new product or edit your existing one. If there a relatively low number of distortions, you can use the Mosaic Editor to improve your outpu...



	Appendix A: Ground Control Point Locations



